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Introduction 
 
 

 

IPGKinematics is a program designed to simulate a vehicle axle on an axle test bench and is 
used to calculate the kinematics, steering kinematics and elastokinematics of a variety of 
suspension types.  

 

For the simulation of high-performance competitive vehicles, such as Formula Student cars, 
the effects of compliance and elastokinematics become less prevalent due to generally stiffer 
suspension components and bushings being implemented - as opposed to that of a consumer 
vehicle as comfort is of a lower priority.  

 

For this reason, it may be more relevant for a team to negate the effects of spring forces and 
torsion to produce a pure kinematics simulation, allowing suspension linkages to move freely 
throughout their range of motion.  

 

This document instructs the user on how to parameterize IPGKinematics to complete a ‘Forces 
Off’ simulation for a Double Wishbone, Pull-/Pushrod actuated suspension system. By ignoring 
such forces, certain inputs do not need accurate parametrization and therefore saving time 
during the modelling process. For ease of use, the following diagrams have been annotated 
using the following key: 

 
 

All other inputs can be left as their default value. At the end of each section, suggested 
settings are provided.  

 

Although not required, it may be useful to use accurate values for all inputs when possible 

if you wish to complete a ‘Forces On’ simulation in the future.  

 

Before reading this document, it is highly advised that the user has a substantial level of 

familiarity with the software which can be gained by completing the exercises within the 

Formula CarMaker Tutorial. This document is intended to be supplementary to the list of 

help manuals provided with CarMaker and therefore explanations offered within are not 

extensive. Example input values can be within the Formula CarMaker Tutorial document.  

= Requires Parameterization  
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Chapter 1 

Simulation Control  

 
 
 

 
 

The Simulation Control GUI allows the user to parameterize the way in which the kinematics 
results will be generated and stored via the General, Kinematics, Compliance and MixedForce 
tabs. It is within this GUI that the simulation can be configured to run with ‘Forces Off’. More 
information regarding Simulation Control and the various settings can be found within the 
IPGKinematics User Guide.  

 
Creating a New File 
 

Before parameterizing simulation settings, the suspension configuration to be modelled must 
be specified first. This can be achieved by navigating to File > New upon the IPGKinematics 
GUI.  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Upon the resulting window the user can select from range of pre-defined suspension 
configurations. As it the case for most open-wheeled race cars, i.e., Formula Student vehicles, 
a Double Wishbone arrangement is often implemented. 

 

It is then recommended to then save the file, ensuring that a name is chosen which 
differentiates from previous simulations - i.e., “DWB_Forces_OFF.kin”.  

 

Figure 1.1 Defining the suspension configuration 
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Simulation Control 

 

 

Simulation Control GUI 
 

This dialog controls the simulation parameters.  

 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

General 
 

Upon the General tab, the following settings should be implemented to run a ‘Forces Off’ 
simulation: 

 

Forces Off should be selected from the Kinematics drop down menu. This ensures that 
neither inertial nor spring forces are considered, and only pure kinematics are calculated. 

 

The options for the output of the calculated tables. Log should be selected which will display 
all results tables within the GUI and will also produce an output file.  

 

To export the results to CarMaker you must choose one of the CarMaker Interface options: 

• CarMaker Interface (1) provides linear compliance model. 

• CarMaker Interface (2) provides a non-linear compliance model. 

As a non-linear compliance model will lead to unnecessarily increased computation times, it is 
recommended to select CarMaker Interface (1). If the Save CarMaker files only option is 
enabled, only the .kin and .skc files will be stored which will reduce memory usage. 

 

 

 

Within the General tab, set: 

- Kinematics = Forces Off 

- Storage of Tables = Log 

- Storage of Results = CarMaker Interface (1) 

 

 

 

 

Kinematics 

Storage of Tables 

Storage of Results 

Simulation Control - General 

Figure 1.2 The General tab of the Simulation Control GUI 
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Kinematics 
 

This tab defines the procedure according to which the movement of the wheels is calculated. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

  
Both wheels of an axle will move in the same direction upon compression when activated. This 
should be set to On. 

 
This option will move the axle’s wheels in opposite directions. This parameter will not affect the 
output of the .skc file but will produce additional files describing the vehicle’s reciprocal 
kinematics, however this may unnecessarily increase simulation time. 

 
This is used only for the front axle to calculate steering parameters. On (1) should be selected 
as it does not consider the interaction between steering and reciprocal wheel travel. 
 
The maximum/minimum values for Compression and Distance Steering Rack should be kept 
close to the designed range to not unnecessarily increase computation time. 
 
 

 
 
 

 Within the Kinematics tab, set: 

- Parallel Kinematics = “On”. 

- Steering Kinematics = “On”. 

- Reciprocal Kinematics = “Off”. 

- Compression = “+/- 30mm”, Stepsize = “5.0”. 

- Distance Steering Rack = “+/- 70mm”, Stepsize = “5.0”. 

 

 
 
 
 
 
 
 

Parallel 
Kinematics 

Reciprocal 
Kinematics 

Steering 
Kinematics 

Compression and 
Distance Steering 

Rack 

Simulation Control - Kinematics  

Figure 1.2 The Kinematics tab of the Simulation Control GUI 
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Simulation Control 

 

 

Compliance and MixedForce 
 

The last two tabs are used to apply external forces to the wheels in the longitudinal and lateral 
directions. These are used to determine the stresses upon individual suspension components 
for FEM analysis. For pure kinematics, external forces are deactivated and compliance is 
irrelevant which is why these options should be configured to Off.  
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
  

- Within the Compliance and MixedForce tabs, configure all settings to Off. 

- Leave numerical inputs as their default values.  

 

  
 

Simulation Control - Compliance and MixedForce 

Figure 1.3 The Compliance tab of the Simulation Control GUI 
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Chapter 2 

Vehicle Data 
 
 

This chapter describes the parametrization of the Vehicle Data section of IPGKinematics, 
accessed via Edit > Vehicle Data. This process mainly involves the specification of various 
hardpoints to allow the software to calculate the various movements of the suspension 
mechanism, however, with ‘forces off’ the definition of some of these components becomes 
redundant as they will no longer have an effect upon the simulation’s results.  

 

This section will therefore identify which settings can be disregarded, and in some instances 
provide suggested values as to prevent the program from producing an error. If you do not 
have values specific to your vehicle, the FCM Tutorial provides representative values.  

 

It may be of interest to enter representative vehicle data where possible for all values in case 
the need for a ‘Forces On’ simulation arises which may save time later, however this may not 
be necessary. In this case, the FCM Tutorial should be referenced when parameterizing.  

 

 

Vehicle Data GUI 
 

General 
 

The General Tab contains miscellaneous vehicle settings.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2.1 The General tab of the Input Data GUI 
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Vehicle Data 

 

 

This option defines which axle will be defined. The Front Axle option will include the 
calculation of various steering quantities. 

 

This parameter does not affect ‘Forces Off’ kinematics. 

 

 

This parameter does not affect ‘Forces Off’ kinematics. 

 

 

For a Formula Student car Chassis Subframe off should be selected as only the chassis 
supports the engine and lower suspension components (i.e. there is no subframe).  

 

This field is used to define the vertical stiffness of the tire (in N/mm). As the tire is modeled as 
a linear spring, a tire spring coefficient must also be entered. To negate the effects of tire 
deflection, it is recommended to enter a high value such as 5000 N/mm.  

 

Here, the static wheel toe and camber angles are defined. The design position is the position 
of the car with only the axle load upon it. This corresponds to a wheel travel of  

0 mm. Therefore, it must be established if the weight of the driver was included in the design 
position calculation or not. If not, attention must be paid to various settings such as the location 
of the center of gravity, camber and toe angles etc. All of these should be measured or 
calculated without the driver’s weight. 

 

This offers the option to model the rack-and-pinion steering rack elastically. However, as 
compliance will not be considered with ‘Forces Off’ this feature should not be enabled. 

 

 

 

 

 
Within the General tab, set: 

- Axle to either Front or Rear - depending upon what you are modelling. 

- Brake Force Ratio and Driving Torque Ratio can be set to any values. 

- Chassis Subframe = Chassis Subframe Off 
- Tire Rate = ‘5000 N/mm’  
- Vehicle and Design Position should be set to representative values.  
- Elastic Mounting Steering Gearbox = Elastic Mounting Steering Gearbox Off. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Axle 

Brake Force 
Ratio  

Driving 
Torque Ratio  

Chassis 
Subframe  

Tire  

Design 
Position  

Elastic Mounting 
Steering 
Gearbox   

 
 
 
 Vehicle Data - General 
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Race Driver Adaption 

Summary 

Vehicle Data 

Springing 
 

The Springing tab features settings for the pull/push-rod, springing and the stabilizer bar.  

 

 

 

 
As ‘Forces Off’ does not consider inertial nor spring forces, many of the settings upon this tab 
merely require a non-zero value to prevent a computational error.  

 

Defines which component the spring is fastened to. It is assumed that the "Spring Fixing" is 
on the suspension side. The option None is chosen in the case of a pull-/pushrod. 

 

This parameter does not affect ‘Forces Off’ kinematics, however you should select pull-
/pushrod.  

 
Defines how the push-/pull rod is connected to the wheel.  

 
 

These parameters do not affect ‘Forces Off’ kinematics, however non-zero values should be 
input to prevent a computational error. These stiffness values are used to consider 
compliance effects of various suspension compnents, which does not concern a pure 
kinematics simulation.  

 
 
 

 
 

Within the Springing tab, set: 

- Spring Fixing = None 

- Stabilizer Bar Fixing = Push-/Pullrod 

- Pull-/Pushrod Fixing = Lower Wishbone 

- All LHS settings = Linear 

- Spring Rates = Default values 

 
 
 
 
 
 
 

Figure 2.2 The Springing tab of the Input Data GUI 

 
 

Spring Fixing 
 
 
 
 

Stabilizer Bar 
Fixing 

 
 
 
 

Parameter 
Spring/ 

Stabilizer/ 
/Pull-/Pushrod 

/Torsion Bar 
 
 
 

Pull-/Pushrod 
Fixing 

 
 
 

Vehicle Data - Springing 
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Vehicle Data 

 
 

Bushings 
 

The drop-down menu upon the Bushings tab allows you to allocate properties to each of the 
bushings of the selected suspension system.  

 
 
 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Again, as compliance is not considering during a ‘Forces Off’ simulation, the specification of 
bushings has no effect upon the results and will therefore be modelled as rigid.  

 

 
 

Within the Bushings tab, leave all parameters as their default values - bushings only need to 
not be parallel to connected members for a ‘Forces Off’ simulation. I.e., the cross product of 
the connected member and bushing axis should not be zero. For a ‘Forces On’ simulation the 
Bushing axis should be aligned with the general axis of rotation of the connected member. I.e., 
the cross product of the connected member and bushing axis should be as large as possible. 

 

Mass 
 

The Mass tab is used to specify the weights of certain suspension system components.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2.3 The Bushings tab of the Input Data GUI 

 

Vehicle Data - Bushings 

Figure 2.4 The Mass tab of the Input Data GUI 
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Vehicle Data 

 

As no mass forces will be considered during the kinematics calculations, these values can be 
left as their defaults. (Note: ‘zero’ values will result in a computational error) 

 

 
 

Within the Mass tab, leave all parameters as their default values - masses do not need to be 
defined for a ‘Forces Off’ simulation.  

 

 

Geometry  
 

The Geometry tab is used to define the hardpoints of various suspension components and its 
correct parametrization is critical to the accuracy of kinematics calculations.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
As the forces associated with the springs and anti-rollbar are not considered, some of the inputs 
merely require a non-zero value to calculate the vehicle’s kinematic properties. These are 
summarized in the following table. 

 

 
 

- Populate the Geometry tab according to the below table. All other inputs can be any non-
zero value during the parametrization process. 

 
 
 
 
 
 
 
 
 

  
 
 
 
 
 
 
 
 

Parameter  Comment  

Wheel Centre - 

Centre of Tire Contact - 

Body - Chassis Subframe Front Can be set same as Chassis Subframe - 
Bushing Front Lower Wishbone. 

Body - Chassis Subframe Rear Can be set same as Chassis Subframe - 
Bushing Rear Lower Wishbone. 

Wheel Carrier - Lower Wishbone - 

Wheel Carrier - Upper Wishbone - 

Wheel Carrier - Steering Rod Not used by rear axle - will still require a non-
zero value e.g., coordinates of Wheel Centre.  

Chassis Subframe - Bushing Front 
Lower Wishbone 

As the subframe is deactivated this 
corresponds to the mounting points of the 
lower wishbones to the body. 

Vehicle Data - Bushings 

Figure 2.5 The Geometry tab of the Input Data GUI 

 

Vehicle Data - Geometry 

Table 2.1:  All Geometry inputs which require parameterizing 
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Vehicle Data 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

All other inputs can be a non-zero value. 

  
 

Saving Results 
 

Once the Simulation Control and Vehicle Data have been configured, the simulation can be 
initiated by clicking the Start button upon the IPGKinematics GUI.  

 

 

 
 
 
 
 
 

This button will momentarily turn grey whilst the simulation is running and will return to green 
once it has completed. The resulting files should then be saved via File > Save.  

 

Amongst the numerous data files generated by the simulation, one will be called: 

 

• NameOfResults_front.skc (for a front axle) 

 

or 

 

• NameOfResults_rear.skc (for a rear axle). 

 

To use IPGKinematics results in CarMaker you must copy the skc-files and paste them 

into the "<yourProjectDirectory>/Data/Chassis" folder of your CarMaker project directory, 

for example: 
 

“FormulaCarMaker_Release2021.1 /Data/Chassis” 

 

This process is demonstrated in the Formula CarMaker Tutorial chapter 5, ‘Preparing a 
Vehicle Dataset in CarMaker’ pg. 75. 

 

 
 
 
 
 

Parameter Comment 

Chassis Subframe - Bushing Rear 
Lower Wishbone 

As the subframe is deactivated this 
corresponds to the mounting points of the 
lower wishbones to the body. 

Body - Bushing Front Upper Wishbone - 

Body - Rear Upper Wishbone - 

Body - Rocker Arm - 

Rotation Axis - Rocker Arm Can be any point upon the rotation axis of 
the rocker arm. 

Pull-/Pushrod - Wheel Suspension - 

Pull-/Pushrod - Rocker Arm - 

Spring Element - Body The point at which the spring assembly is 
connected to the vehicle body / chassis. 

Spring Element - Rocker Arm The point at which the spring assembly is 
connected to the rocker. 

Figure 2.6:  Start button upon IPGKinemtics GUI 

 


